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1.  Introduction
Supply pipes that transport vitally important commodities like drinking water, for
example, needed to be checked and monitored especially thoroughly and ex-
tremely carefully. Prevailing pressure values provide valuable information with
regard to fire protection and the sustainability of supplies. 

In order to ensure that such supplies are indeed as sustainable as they should
be, including during peak times when demand is at its greatest, measurements
have to be carried out using pressure loggers.

In such cases, pressure loggers are installed at certain positions or specific
intervals along the section of pipe in question. Whenever water is taken from the
pipe, a drop in pressure occurs. The pressure profile over this measurement
section provides the user with extremely important information concerning the
condition of the pipes that are being monitored. In addition, the measuring results
can be displayed in a diagram so as to provide a graphic illustration of the pres-
sure values as determined by the individual loggers.

In order to provide you, the user, with the best possible support and to ensure
that you get the maximum benefit from your product, we have developed the 
LogControl DL software, which has been designed specifically to assess the 
measuring data which the receivers have collected. The software also enables
you to program a pressure logger to carry out a measurement. The measuring
data that has been read out can then be displayed as a measuring curve. In
addition, different measuring curves can be overlapped and measurements 
can be exported to Excel for further processing.

2.  Program Configuration

2.1 Main Menu
There are a number of menu options available which enable you 
to control the program functions.

Figure 2-1: Main menu

In the “File” menu you will find a number of program functions which 
enable you to save or load measurements. You can also use this 
menu option to end the program.

You can go to the menu item “Settings” to change 
different program characteristics. 

Among the more important features which can be changed using this menu are
the language and the graphic depiction of the diagram. In addition, you can also
change the configuration of the communication parameters which control the
data exchange between the readout units. Furthermore, you can reach the GSM
modem administration mask via this menu. 

The last menu item enables you to call up the “Backup assistant”. The backup
assistant is necessary in order to be able to initialise and update the database.

You can change between the program’s two different transfer modes 
in the “Mode” menu.

File ModeSettings

Open Strg+O

Save as Strg+S

Additional information Strg+A

Finish Strg+E

Language GSM Mode

Communication Serial / USB mode

Help

Info program

Info readout unit

Chart

GSM modem list

Database

This publication replaces all previous publications. No part of this publication may be reproduced, processed using
electronic systems, replicated or distributed in any way without prior written authorisation by us. Subject to technical
modifications. All rights reserved. Names of goods are used without guarantee of free usage and used for the most part
according to the manufacturers‘ syntax. The names of goods used are registered and should be considered as such. We
reserve the right to modify the design in the interest of ongoing product improvement, such as shape and colour
modifications. The scope of delivery may vary from that in the product description. All due care has been taken in
compiling this document. We accept no liability for any errors or omissions.

The “Serial/USB mode” is the standard mode which was previously used in the
program. This mode can be used to control the readout circuit boards which are
connected to the USB. The “GSM mode” is designed to enable you to read out
pressure loggers which are equipped with a GSM modem.

The GSM modems must first be configured and registered with the program. You
can carry out modem setting configurations via the menu item “GSM modem
list” in the “Settings” menu.

The “Help” menu allows you to access all information regarding contact data,
the program version and hardware information of the readout circuit board. 

You will find a detailed description of the individual menu items 
in chapter 3 (“Main Menu”).

2.2 Toolbar
The toolbar, which you will find under the main menu, provides you with a variety
of shortcuts and useful functions (see fig. 2-2). The functions are, however, limited
to a specific context and are therefore not always available. If a function cannot
be used in a certain context, it will appear on the toolbar as a grey icon. 

See chapter 3.5 (“Toolbar”) for a detailed description 
of the individual functions.

Figure 2-2: Status bar

2.3 Status Bar
The status bar (see fig. 2-3) provides you with information regarding the history
of the functions that have been called up. This appears both in the form of a text
describing which tasks have been performed as well as a progress bar which
provides the same information in graphic form.

Figure 2-3: Status bar

2.4 Sectors
There are two different sectors with different functions in the LogControl DL
program. The two sectors, “Pressure logger and measurements” and “Measuring
curve”, provide the user with a variety of different context related functions.

2.4.1 Pressure Logger and Measurements

This sector of the program shows all
the measurements that have been
saved into the database, as well as
all the measurements on the data log-
ger readout circuit board and all new
measurements (see fig. 2-4). 

You can select either a measurement
or a pressure logger to gain more de-
tailed information on either of the
two. The information appears below
the sector “Pressure logger and
measurements” and provides you
with additional data on the object you
have selected (see table “Additional
Information”).

You are also able to access the con-
text related functions of the toolbar
in this sector when you have selec-
ted an object. 

Figure 2-4: 
“Pressure logger and 
measurements” sector
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When you select a pressure logger, you are able to access the buttons from 1 to
6 in the toolbar (see fig.2-2). You are able to access the buttons from 7 to 9 and
11 to 15, which are designed to provide the user with a series of additional
functions when you select a measurement. 

See chapter 3.5 for more information on the individual functions.

Table: Additional Information on Measurements / Pressure Loggers

2.4.2 Measuring Curve

In the “Measuring Curve” sector, the values of the pressure logger are displayed
as a diagram. The type of diagram displayed is a line diagram. 

The individual pressure values are entered into the Y-axis and the time is entered
into the X-axis (see fig. 2-5). 

The time is depicted on the x-axis as a measuring curve with the units hours,
minutes and seconds (hh:mm:ss). 

If several measuring curves are to overlap, the units can also be in months and
years, depending on how far apart the starting times of the individual measure-
ments are.

Figure 2-5: “Measuring curve” sector

Additional functions in this sector can be accessed via the buttons 
as shown in fig. 2-5. 

If the displayed view is of a single measuring curve, then you can click on the
buttons “Divide” or “Calculate” to divide the measuring curve up into two or
more curves or to calculate the pressure difference between a maximum and
minimum measurement. 

If the displayed view is of two or more measuring curves, you can click on the
buttons “Overlap” and “Mark” to either overlap different measuring curves or
select data information which you would like to export to Excel. 

See chapter 4 for more detailed information on the 
individual functions in this sector.

Measurement Pressure logger

Start time Serial number

End time Measurement values

Measuring period Measurements

Interval time Software version

Measuring values Pressure sensor

Battery voltage int. /ext. Calibration

Min. air pressure / Max. air pressure Battery voltage

Absolute max. / Absolute min.

Absolute difference

max. pressure / min. pressure

Pressure difference

3.  Main Menu
The individual menus and their respective sub-menu items are 
described in detail below:

3.1 “File” Menu 

3.1.1 Opening a File 

From program version 1.0.1.5 onwards, you are able to save data into a separate
file. This allows you to exchange measurements with another LogControl DL
program version if necessary.

To open a file which always has the ending “dfl”, select “File” > “Open” in the
menu or press the key combination STRG + O. A dialogue allowing you to select
the file you wish to open will appear. Click on “Open” to load the file.

Please remember that due to the fact that there are different versions of the
LogControl DL program not all “dfl” files can be opened with each program
version. The latest program version, Version 1.0.3.20, for example, is always able
to access saved data including that of the all predecessor versions (1.0.1.1 to
1.0.2.17). The predecessor versions, however, are not able to access the data
that has been saved by later versions.

Depending on the size of the measurement, loading can take a few seconds to
complete. The file can then be seen in the sector “Pressure logger and meas-
urements” (chapter 4.1). 

When the file has been opened, the measuring data is saved into the database
and will be shown every time the program starts. You can delete the measure-
ment as described in chapter 3.5.11 if you would prefer not to have the data
displayed every time the program starts.

3.1.2 Saving a File

In order to be able to load measurements, the measuring data mentioned above
must have the suffix “dfl”. Such files can either be created by either clicking on
the menu item “Save” or by pressing the key combination STRG + S.

First mark the measurement which you would like to save as described in chapter
4.1. When you have marked the measurement, the menu item “Save as” in the
“File” menu becomes available. Click on the menu item. 

When this function has been called up, a dialogue appears which allows you to
enter the file path and the measurement. Click on “Save” when you have entered
a file name and the relevant file path so that the measurement can be saved into
the new file. 

When a measurement has been saved, it is still available in the sector “Pressure
logger and measurements” (see chapter 4.1.). If you would not like the
measurement that has just been saved to appear in this sector, you can delete
the measurement as described in chapter 3.5.11.

3.1.3 Entering Additional Information

You can also add additional information to each individual measurement in the
database as described in chapter 4.2.3. 

From the program version 1.0.1.5 of the LogControl DL program onwards you
can also easily access this information window via the menu item “Additional in-
formation” in the “File” menu. You then only have to select the relevant meas-
urement as described in chapter 4.2.3.

File

Open Strg+O

Save as Strg+S

Additional information Strg+A

Finish Strg+E
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3.1.4 Ending a Program

Select “File” > “Finish” or press the key combination STRG + E to end the
program. You do not need to save the measurement explicitly as it is saved by
the program automatically. 

Only measurements with a red exclamation mark will not be saved because an
error occurred while they were being read out.

3.2 “Settings Menu”

3.2.1 Language

Go to the menu “Settings” > “Language” to change all texts and textual
presentations to the language of your choice. 

The program supports up to 14 languages. The language packs, which can be
used immediately after the program has been installed, are integrated in the
program and cannot be changed.

As a result you can only select from the languages that are available from the
“Language” menu when the installation has been completed. A so-called lan-
guage file has to be created first for other languages.  

In order to make it easier for you to customise your program, the program creates
a template of the language file during installation. The template is in the “lang”
folder. The “lang” folder is in the installation directory of the LogControl DL program. 

If, for example, you have installed the program under “C:\Programs”, then you
will find the installation directory under “C:\Programs\LogControl DL” and the
template for the language file under “C:\Programs\LogControl DL\lang”.

When you open the “lang” folder, you will see the template with the name
“Language.properties”. This file can be opened and processed using either 
Editor or WordPad.

Before you can process the file, you have to create a copy of the file “Language.prop-
erties” in the same folder. This is because the template itself should not be 
changed in order to prevent errors from occurring in the program.

You must therefore never change the template, only the copy !

To create a copy of the file, mark the file by left clicking on it and then mouseover
the marked file and right click. 

A so-called popup menu appears. Select the option “Copy” and left click again. 

The copy of the file must be added to the same folder. Go the “Edit” menu and
select the command “Paste”. 

The “lang” folder should now contain a further language file with the name “Copy
of Language.properties”. This copy can now be customised to suit your language.

When you have finished customising the file, the name of the language file must
also be customised for the program so that it can identify the file and load it. Use
the following conventions to designate a name for the copy of your language file
“Copy of Language.properties”).

German

English

French

Italian

Spanish

Portuguese

Swedish

Norwegian

Danish

Polish

Russian

Chinese

Czech

Slovenian

Readout unit
Modem
Modem settingsMarker points

Level threshold

On
Off

Settings

Language

Communication

Chart

GSM modem list

Database

•    French > “Language_fr_FR.properties”
•    Spanish > “Language_es_ES.properties”
•    Italian > “Language_it_IT.properties”
•    Danish > “Language_da_DK.properties”
•    Norwegian > “Language_no_NO.properties”
•    Swedish > “Language_sv_SE.properties”
•    Portuguese > “Language_pt_PT.properties”
•    Polish > “Language_pl_PL.properties”
•    Russian > “Language_ru_RU.properties”
•    Chinese > “Language_zh_CN.properties”
•    Czech > “Language_cs_CZ.properties”
•    Slovenian > “Language_sl_Sl.properties”

3.2.2 Communication

In the version 1.0.3.2, the menu “Communication” was expanded and now
contains configuration parameters for GSM communication. 

In contrast to the menu item “GSM modem”, which is described in more detail
in chapter 3.2.4, hardware components which are connected to the computer
are configured via these menu items. 

These include the readout units which are used to read out the pressure loggers
and modems which are needed to set up a connection to the pressure loggers.

The interface parameters must be configured before you can import the data
from the pressure logger into the LogControl DL program. The readout unit is con-
nected to the computer via the USB port and creates a virtual serial interface
called “COM port” in the operating system. 

When you click on the menu item “Settings” > “Communication” > “Readout
unit”, the dialogue as shown in figure 3-3 appears. COM port can be selected in
the first box. The following parameter settings for the COM port should be re-
garded as standard values and should therefore be set accordingly. 

Click on “Save” to save the settings. The pressure logger can be read out as
described in chapter 3.5.1.

If you are unable to select a COM port after the readout unit has been connected
and the LogControl DL program has been started, the hardware driver must first
be installed. Please end the LogControl DL program and install the USB driver
from the installation CD. 

A further possible reason which would explain why the COM port is not shown in
the dialogue is a change in the Java environment. This could other be because
Java has been updated or installed again. 

Please end the LogControl DL program and execute the “ComFixPatch”
from the installation CD.

Figure 3-3: “Serial communication settings” 
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In order to be able to communicate with the pressure logger, which is read out
via a GSM modem, the program needs a modem to set up a connection between
the program and the GSM modem. 

The connection to such a GSM modem can either take place using either a cable
modem or a GSM modem. 

As was the case with the readout unit, the interface parameters for the modem
that is connected to the computer also have to be configured first. 

In order to do so, click on the menu item “Settings” > “Communication” > “GSM
modem”. A dialogue like the one used to configure the readout unit appears. 
The only difference between the two dialogues is the parameterisation of the
interface settings.

The COM port is dependent on the operating system in this case too and is also
named by the system although this is different from the readout unit. 

If you have bought a modem from Trotec to communicate with the logger, then
you can use the following parameters which can be regarded as standard values
to configure the interface.

• Baud:                 9600
• Data bits:            8
• Stop bits:            1
• Parity:                 none
• Flow control        none

Go to the menu item “Settings” > “Communication” > “Modem settings” to
get to the dialogue as shown in figure 3-4. The dialogue contains the initialisation
parameters which are sent to the modem that is connected to the computer while
the link is being connected. 

Figure 3-4: “Modem settings” dialogue

If you have bought a modem from Trotec, you can use either the “GSM” or the
“Cable” button to call up the standard parameters. The designation of the buttons
reflects the type of modem which is connected. 

Furthermore, you can use this dialogue to communicate the prefix for the outside
line if you wish to operate it as part of a telephone system. 

If, for example, you need to dial “8” to get an outside line, enter “8” into the box
before the check box “Dial zero first”.

Then click on the control box. A tick will appear. From now on an 8 will precede
any telephone number that is dialled to get an outside line. 

All the changes that are performed in this dialogue can be saved by clicking on
the “Save” button or rejected by clicking on the “Cancel” button.

3.2.3 Diagram

You will find all functions which could have in some way have an effect on the
diagram in this menu. 

Go to the menu item “Settings” > “Communication” > “Marker points” to show
or hide the measuring points. The measuring points will either be shown as 
small filled circles, or if you have selected the option “Off”, as connecting lines
between the individual measurement values. 

The second menu item “Settings” > “Communication” > “Threshold values”
is designed to hide the threshold values when operation controlled measurements
are carried out. That means that the threshold values which are depicted as chain
lines are not shown in the diagram when the menu item “Off” has been selected.

3.2.4 GSM Modem List

A general depiction of the information flow between the program and the pressure
logger can be seen in figure 3-5. 

As you can see in this depiction, two modems are involved in GSM readout. 
One is connected directly to the computer and the other is connected directly 
to the pressure logger. 

The settings of the modem that is connected to the computer via a cable and that
is referred to in figure 3-5 as the cable modem can be changed using the menu
“Settings” > “Communication” This modem is in contrast to the GSM modem
completely autarkic with regard to program settings. 

Figure 3-5: GSM set up diagram

The settings for the GSM modem, which enable the pressure logger to set up a
connection via the GSM network, can be configured using the “GSM modem
online times” dialogue as shown in figure 3-6. You will find more information on
this subject in the following chapters.

The window is divided into three main sectors. The first sector is the toolbar 
which enables you to access functions that allow you to read information like
“SIM ID”, “Time”, “Battery voltage” and “Error memory” out of the GSM modem. 

The second sector is in the left-hand part of the window below the toolbar and
shows the GSM modem connection parameters as stored in the database. The
third and final sector is to the right of this sector. The third sector is used to
configure and save modem online times as well as to change the parameters of
the SMS status messages.

Figure 3-6: “GSM modem online times” dialogue

Program LogControl DL

PC

USB

Cable modem

GSM modem

GSM net
Readout unit

Pressure logger
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In order to be able to program or change the online times the modem has to be
connected to your computer via the USB cable included in the scope of delivery. 

The connection between the modem and the program has to be configured as a
“readout unit” as described in chapter 3.2.2. 

In order to do so you must first press the key on the modem before you connect
the modem to your computer using the USB cable. When you press the key, the
modem‘s green LED starts to blink to indicate that the modem is ready to com-
municate. 

Now you can connect your modem to your computer and configure the interface
between the program and the modem. After that you may call up the dialogue
“GSM modem online times”.

Toolbar

As shown in figure 3-6, and as explained previously, you will find four functions
in the toolbar of the “GSM modem online times” dialogue. 

The first function on the toolbar enables you to read out the modem’s
SIM ID. 

When the information has been read out and there is a data set with the SIM ID
that has just been read out in the database, then the data set is marked in the
table along with the modem online times providing these have already been con-
figured. If there is no data set with the SIM ID in the table, then the dialogue as
shown in figure 3-7 will appear.

Figure 3-7: “Modem number” dialogue

You can enter the mobile number as well as a short text regarding the location of
the modem in the “Modem number” dialogue You can make the modem to 
build up a connection with the pressure logger (see chapter 3.5.1) by ticking the
“YES / NO” box. 

If you do not tick the box, the program will only read out the pressure logger when
the connection times of the pressure logger modem are identical with those of
the computer. 

Click on “Apply” to save the data into the database. If you do not wish to save
the data, then click on “Close”.

The second function can be used to change the modem time. When you
click on the button, the program reads out the current modem time and

displays this time in the dialogue. Change the time in this dialogue if necessary
and click on “Save”.

The third function in the toolbar can be used to gain information on the
battery status of the modem. Click on the button to see the voltage level

of the internal and external battery.

The fourth function on the toolbar enables you to read out the error memory
of the modem. The error memory contains all relevant information on

individual dial ups. Any significant incidences regarding the power supply are also
written into the error memory.

Left sector

As explained above, the available modems are listed in the left-hand sector of
the “GSM modem online times” dialogue. 

In this context available means the modems can be queried by the program when
the telephone number has been entered into the “Modem number” dialogue (see
fig. 3-7) and the dial up times have been configured. The table also displays all
information contained in the dialogue as shown in figure 3-7. 

Click on “Delete” to remove a data set from the table, 
i.e. delete modem settings from the program. 

Click on “New” to enter a new data set into the table manually. The program will
then attempt to read out a connected modem. What the program actually does
is try to identify the SIM ID. If a modem is not available, the “Modem number”
dialogue opens without automatically entering an SIM ID. You can now add the
missing information and click on “Save” to apply the data to the table. 

Click on “Update” to update a data set which has been marked in the table with
new data from a modem. Connect the modem to your computer so that the
pressure logger can be read out at the modem as described in chapter 3.5.1.
When this has been completed, you can open the dialogue and select a data set
in the table and then click on “Update”. The so-called online times (dial up times)
and the text message settings are then updated.

Right sector

The right-hand sector of the dialogue is divided into “GSM turn on times” and
“SMS turn on times”. Because the GSM modem is only equipped with rudi-
mentary text message support, these operating instructions will not deal further
with this part of the program.

The sector “GSM turn on times” enables you to program up to five time frames
into the modem. The time frames have a date and time at which they start 
and a date and time at which they end. 

Double click on one of the lines in the table to open the dialogue as shown in
figure 3-8. You can use this dialogue to enter both the starting and ending times
of the individual time frames. Please ensure that time frames do not overlap. If,
for, example, two time frames do overlap, then neither of the time frames will be
transferred to the modem.

Figure 3-8: “Programming the time frame” dialogue

When you click on the “PC time” button, the boxes which display the current
computer time appear. You can either press “Save” to store any new settings or
“Close” to end the dialogue without carrying out any changes. 

You can change the values in the individual boxes by either selecting a certain
figure or by pressing the arrow keys to the right of the boxes until you have
reached the value you wish to enter.

Below the table in figure 3-6 you can see the segment “Repetitions”. In this
sector you can change settings regarding the dial up times, i.e. the dial up times
you have entered can be repeated at selected intervals. 

If you have selected the box “NONE”, the measurements will only be carried out
at the previously selected time. If you select the box “Daily”, the measurement
will be repeated on the following day. 
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You can determine the number of repetitions by entering a number into the
“Number of periods” box. The number of repetitions can range from one to a
theoretically infinite number if the box “Permanent” has been selected.

Please note that the settings are initially saved into the database and 
not immediately into the modem. 

The settings have to be transferred explicitly to the modem for them to be saved
there. In order to do so click on “Apply”. 

When they have been transferred, the program will show you how many meas-
urements have been saved into the modem. 

If the number of saved measurements is different to the measurements in the
table, then there has been an overlapping of dial up times. You should remedy
the situation and transfer the online times to the modem again because the
modem is only online at the dial up times that have been entered.

3.2.5 Database

In the menu “Settings” > “Database”, you can use the database assistant to
either reinitialise the database or to carry out a software update or to update the
database. 

Furthermore, you can use the database’s backup assistant to create a backup
of your data which will allow you to restore the data if necessary.

1. Database Initialisation

Start the database assistant via the menu “Settings” > “Database”. The window
“Database initialisation” then opens.

Click on the “User” button to enter the user name and the password that will
allow you to access the database (see fig. 3-9).

Figure 3-9: Entering the database user

Confirm by clicking on “Apply” and then on “Initialisation” to start creating a
table. If you do not wish to perform a database initialisation, click on “Cancel”
and then on “Close”.

Attention: Be sure to only perform an initialisation of the 
database when you have installed the program for the first time. 

This is because the existing database will be recreated and all 
previous measurements will be lost.

You will receive a message warning you that a database exists (fig. 3-10). 

Confirm by clicking on “OK” so that you can continue with the assistant. 
Remember that all the values that have previously been saved into the 
database will be lost. Click on “Cancel” if you would like to stop the 
database initialisation procedure.

Figure 3-10: Warning!

2. Updating the Database 

In some cases you may have to update the database after you have carried out
a software update. A message will then appear informing you thereof. When 
you update the database, all previously saved values remain in the database.
Click on “Update” to begin the database update.

Possible error messages during the procedure

Error message 1: 
The assistant cannot find the correct path. 

Check to see if the path you have entered exists. If this is not the case, try to
install the software again or contact Trotec.

Error message 2: 
The program was not able to set up a connection to the database. This could be
because the wrong password was entered, “MySQL” was either terminated or
not started properly or the database is blocked by a firewall.

Ensure that you have entered the correct password and check to see if “MySQL”
has been started properly. Deactivate your firewall for the duration of the up-
date if one is installed.

3. Backup Assistant

You can use the backup assistant to create a backup of the database or to re-
store your data using a back up file which you have already created. A backup
file contains all the measuring values which were in the database at the time the
backup was performed. 

Please note that some measurements may be lost when a backup file is used to
restore data. This is because the contents of the database as well as the
configuration file are overwritten by the data which was saved when the backup
was performed. We therefore recommend that you perform a backup at regular
intervals in order to ensure that your database always contains the latest data.

Select the menu “Settings” > “Database”. 
The dialogue window “Database initialisation” will then appear.

You will also need administrator rights to access the database. Select the “User”
button and enter the user name and the password that is required to access the
database into the “Database user” window. Click on “Apply” to confirm and then
on “Backup / Restore” to start the backup assistant.

Attention: Before the backup assistant is used for the first time, the
program must be informed about the MySQL installation directory so

that the assistant is able to perform a backup. Select “Server path” at the
bottom left-hand corner in the “Database initialisation” window.

A dialogue window in which you have to enter the relevant installation path of
the “mysqldump.exe” file will open. If you have installed MySQL under
“C:\Programs\MySQL” for example, then you will find the directory of the
“mysqldump.exe” file under “C:\Programs\MySQL\bin”. 
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When you have selected the directory, the required file will appear in the dialogue
window. Mark the file and click on “Open”. The path will appear to the right of
the button “Server path”.

When you have started the backup assistant, a window will appear as shown in
figure 3-11. You can now select either the “Backup” or “Restore” button in the
left-hand navigation bar to call up the relevant functions. The information in the
right-hand part of the window depends on the context and changes according
to the selections which have been made. 

Figure 3-11: Backup assistant dialogue window

a) How to Backup Data

Click on “Backup” in the left-hand navigation bar to perform a backup. Select
the memory place for the backup file (fig. 3-12) above the button “…”. The
“Restore” button cannot be selected during this procedure. 

Click on “Back” to return to the back up assistant dialogue window.

Figure 3-12: “Backup” assistant

A back up can only be started when a memory place for the backup file has been
selected. If you select “Backup” without having previously selected a memory
place, then you will be requested to do so by the program. Click on “OK” to close
the request and select a memory place for the backup file using the “…” button. 

A window in which you can enter the path where the backup file is to be saved
will open. The program automatically assigns a name to the backup file. The
name comprises the name of the program, the current time and date and the
version of the Log DL program.

Example: Backup_LogControlDL_08-45-28_08.11.2010_Ver. 1.0.5.30.zip

Click on save. The path you have selected for the memory place appears 
in the text box (fig. 3-12). 

In addition the program generates and attaches a file. Now you can click on
“Start backup” to create a backup file. A message will appear when the backup
has been completed. Finish by clicking on “OK”

Click on the “Back button” to return to the backup assistant dialogue window.

b) How to Restore Data

Click on “Restore” in the left-hand navigation bar to restore data. Click on the
“…” button in the right-hand part of the window to select the backup file which
you require to restore the data (fig. 3-13). 

The “Backup” button cannot be selected during this procedure. Click on the
“Back” button to return to the backup assistant dialogue window.

Figure 3-13: “Restore” backup assistant

A restore can only be started if you have selected a backup file first. If you select
“Start restore” without having previously selected a backup file, then you will
be requested to do so by the program. Click on “OK” to close the request and
select a backup file using the “…” button. 

A dialogue window opens. Select a backup file and click on “Open”. The name
of the file appears in the text box (fig. 3-13). Click on “Start restore” to com-
mence the procedure.

Please note that all program relevant data in the LogControl DL directory as well
as all the values in the database will be deleted and written over with the backup
data. A message informing you thereof will appear. Click on “Yes” to continue
to restore the data or “No” to return to the previous window.

If you have selected an invalid backup file, you will not be able to continue to
restore the data. An error message will appear. Click on “OK” and select a valid
backup file. 

If the version number of the backup file (the last position in the file name behind
the date the file was generated) is different to the current program version, then
you will also be unable to restore the data.

An error message will appear. Click on “OK” to close the message and 
select a valid backup file. 

Click on “Start Restore” to resume restoring the data. The LogControl DL directory
and the database will be written over by the backup file. 

A progress bar will inform you of the status and a message will appear when
the data has been restored successfully. Click on “OK”. The procedure has now
been completed. 

Click on “Back” to return to the backup assistant dialogue window.

Program version Backup File

1.0.3.21 1.0.3.20 Restore possible

1.0.3.21 1.0.2.17 Restore not possible
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3.3 “Mode” Menu

You can change between the two program communication modes 
in the “Mode” menu. 

The “Serial / USB mode” is the program’s standard mode. The program
automatically switches to this mode every time the program is restarted. All
previous LogControl DL program versions run in this mode. That means that 
communication between the application and pressure logger can only take 
place via the USB readout unit connected to the computer. 

The second mode which the program is equipped with since Version 1.0.3.20 is
the so-called “GSM mode”. This mode enables the program to communicate
with the pressure logger via a modem that is connected to the computer. The
modem must, however, first be configured as described in chapter 3.2.2. 

The pressure logger which is to be read out also requires a GSM modem. This
modem must be registered with the program and configured as described in
chapter 3.2.4. 

As soon as these two steps have been completed the GSM mode can be used to
its full potential. This means that the program can be operated as before with the
exception that communication now takes place between the modem and the
pressure logger (see chapter 3.5.1).

There is a graphic display in the toolbar (chapter 3.5) which enables you to tell
which mode the program is in more quickly. A yellow icon (fig. 3-15) at the right
end of the toolbar appears when the program is in “Serial / USB mode”. 

Figure 3-15: “Serial / USB mode” icon

If, however, the GSM mode has been selected, the graphic at the right end of the
toolbar changes to a pink and red icon (see fig. 3-16).

Figure 3-16: “GSM mode” icon

3.4 “Help” Menu

3.4.1 Program Information

You will find detailed information on the program version of the installed program
as well as details on how to contact Trotec in the “Help” menu under the menu
item “Info program”.

3.4.2 Readout Unit Information

A further information window which can be called up using the menu item “Help”
is the window which contains information on the readout unit. The information 
in this window is necessary for some program updates because some new fea-
tures in the PC program may require that the readout unit and the pressure logger
be updated.

When this function has been called up, a dialogue window containing information
on the software and hardware status and the readout circuit board will open.

Mode

GSM Mode

Serial / USB mode

Help

Info program

Info readout unit

You will only receive this information if the readout circuit board is connected 
to the computer and the interface has been configured correctly in the program
(see chapter 3.2.2) and a pressure logger is on the readout unit. If not an error
message will appear. 

An error can occur while the information is being read out if the readout circuit
board has an older software version.

As explained above, you may have to update your logger components in order to
be able to use all the functions in the LogControl DL program. The new functions
for the logger (see chapters 3.5.3 and 3.5.4) require that your pressure logger is
at least equipped with the software version 1.4 and the readout circuit board 1.3. 

3.5 Toolbar
The following chapter describes the individual functions which 
are available in the toolbar. 

The availability of the functions depends on the object which has currently been
selected in the sector “Pressure logger and measurements” (see chapter 2.4.1).
The functions “Read out pressure logger” and “Overlap measuring curves” are
not context dependent and can be used at any given time.

3.5.1 Reading Out the Pressure Logger 

Select this menu item when you wish to read out the pressure logger. In order to
perform this function a pressure logger must either be connected to the program
via a readout unit or a modem. 

If you use a readout unit to read out the data, you must ensure that all drivers
and the COM port are installed and configured as described in chapter 3.2.2. 

When you click on the button in USB mode, the program starts to read out the
pressure logger. There is also a status bar which shows you how far the readout
has progressed (see chapter 2.3). 

When the data has been read out, a pressure logger symbol will appear in the sector
“Pressure logger and measurements”. If the pressure logger has saved any meas-
urements, then you will also see symbols of measurements in this sector.

You also have to click on this button to read out the pressure loggers via a GSM
modem. The telephone numbers and reception times of the modem have to be
configured first (see chapter 3.2.4). An error message will appear if the telephone
list is empty and the pressure logger cannot be called up. 

The same error message will appear when you click on the button and none of
the pressure logger modems are ready to receive. When all the settings have
been performed correctly and at least one GSM modem is ready to receive, the
connection will start to build up and the logger will be queried when you click 
on the button. 

As in “Serial / USB mode”, the program’s status bar enables you to see how far
the connection has been built up and the status of the data readout. If more than
one modem is ready to receive at any one time, then the program will build up a
connection to one modem after another. This means that in effect all the ready-
to-receive modems will be read out one after the other.

3.5.2 Setting the Pressure Logger Time 

As is the case with the function “Read out pressure logger”, this function re-
quires that a pressure logger is connected to the computer either via a readout
unit or a GSM connection (see chapter 4.1). 

When these requirements have been met, a new window in which you can enter
the time and date of the pressure logger (see fig. 3-17) will appear as soon as
you click on “Set pressure logger time”. 

Click on “Save” to transfer the settings which you have selected to the pressure
logger. Click on “Cancel” if you wish to terminate the procedure without saving
the settings you have previously selected.
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Figure 3-17: “Pressure logger settings” window

3.5.3 Resetting the Pressure Logger 

This function can be used to delete all the measurements that have been saved
into the pressure logger. This applies to all measurements that have been completed. 

Measurements which still have to be carried out or measurements which are
currently being performed (see chapter 3.5.5) will remain in the memory of the
pressure logger. These have to be deleted explicitly using the pressure logger’s
keypad if this is intended. 

In addition, all requirements as listed in item 3.5.1 must be met 
in order to be able to use this function.

3.5.4 Pressure Logger Real-time Read Out 

A further new function that is available from the program version 1.0.1.5 onwards
is the function “Real-time read out” This function enables you to follow a meas-
urement that is being currently carried out with the pressure logger program, i.e.
the pressure logger can be used much like a pressure recorder.

This function is normally used when the pressure logger is integrated in 
the pipe system that is being monitored, i.e. the pressure logger is 
a fixed part of the installation. 

In such a case you must remember that communication between the computer
and the logger cannot be effected immediately as the pressure logger is equipped
with a tilt sensor which prevents communication when it is an integral part of an
installation. The reason is to conserve battery power. 

It is, however, possible to put the pressure logger in communication mode when
it is an integral part of an installation by pressing one of the pressure logger’s
keys. As soon as one of the keys has been pressed, information on the measurement
which is currently being carried out will appear on the pressure logger’s display.
Communication between the computer and the logger can now be established.

Place the readout circuit board that is connected to the computer over the logger
display and read out the logger as described in chapter 3.5.1. 

After a short synchronisation pause between the computer and the logger, the
pressure logger will appear as a symbol in the sector “Pressure logger and meas-
urements” (see chapter 4.1). Select this symbol and call up the function “Real-
time readout” from the menu bar. The measuring values of the current measure-
ment will then appear in the sector “Measuring curve” (see chapter 4.2) in ac-
cordance with the interval times.

The pressure logger does not have to be connected to the modem manually in
GSM mode, as they are then already connected permanently. You must only en-
sure that a connection between the logger and the GSM modem is set up as
described in chapters 3.5.1 or 4.1 Then select a pressure logger symbol in the
sector “Pressure logger and measurements” and perform the real-time readout
by clicking on the button.

3.5.5 Programming Measurements 

You can use this function to program the pressure logger. 

That means that you can either program 5 time controlled measurements (TCM)
or 1 single operation controlled measurement (OCM), which you can then read
out with the LogControl DL program. 

Each type of measurement is fundamentally different to the other. 

When you carry out a time controlled measurement (TCM), you enter the duration
of the measurement along with the starting time. That means that the measurement
has a defined starting time which you yourself select and a defined end, which
depends on the interval time and the number of measuring values. 

When you carry out an operation controlled measurement (OCM), the measure-
ment starts when either the upper or the lower pressure threshold is exceeded.
When one of these thresholds, which have been previously predefined by you, is
exceeded, then the pressure logger measures 5,500 measurement values per
triggered measurement.

It is important to remember that the pressure logger is equipped with a ring
memory which allows the logger to save up to 240,000 measuring values. This
means that any measurements which were carried out before the last 240,000
measuring values are saved are overwritten and therefore deleted. 

The measurements which have currently been saved and the resulting measuring
values are shown in the window “Program measurement” (fig. 3-18) below the
table in which the measurements which are to be programmed can be seen. Fur-
thermore, it is necessary that the pressure logger and the readout circuit board
are connected to the computer during the whole measuring program or connec-
ted to a GSM modem when a GSM connection has been established.

Determining Measuring Parameters

In the left half of the “Program measurement” window there is a calendar which
shows the current month. You can determine the starting day of a measurement
by selecting a specific date in the calendar. Mouseover the date you wish to 
select and left click.

Figure 3-18: “Program measurement” window

When a date has been selected, click on to open the window shown in fig.
3-19 and set the parameters for a TCM (time controlled measurement). 

Click on to open the window shown in fig. 3-20 to program the OCM 
(operation controlled measurement).

Please note that the two measurement methods cannot be mixed, i.e. you can
either program 1 OCM or a maximum of 5 TCMs. The next two sections will 
show you how the measuring parameters are determined.

Setting the parameters for a TCM (time controlled measurement) 

In the top half of the “TCM measurement parameters” window (fig. 3-19) you
will see the date on which the measurement is to be carried out. You can change
the starting time by entering a value into the text box “Starting time”. In order to
do click on either the hour, minute or second value and then on the arrow keys
to the left of the box to change the starting time.

Proceed in the same manner to change the parameters for the boxes “End time”
and “Interval time”. 

You can change both the time and the date in the “End time” box. The value that
has been selected in the “Interval time” box shows the time between two meas-
urements. That means the bigger the value, the fewer the number of measuring
values for a measuring period.
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Click on “Apply” to accept the measuring values or on “Close” if you wish to
terminate the procedure. 

When you have clicked on “Apply” the measurement will be shown in the table
in the main window “Program measurement” (fig. 3-18) and the day on which
the measurement is to be carried out will be highlighted in blue in the calendar. 

Figure 3-19: “TCM measuring parameters” 

Setting the parameters for an OCM 
(operation controlled measurement) 

You can use the window shown in fig. 3-20 to set the OCM parameters. In the
upper part of the window you will see the date on which pressure monitoring is
to start. You can either change the starting time or the time you would like
monitoring to end in the lower part of the window. 

You can either enter a value directly into the box or change the values by pressing
the arrow keys to the right of the boxes. Proceed in a similar manner to change
the boxes “Maximum”, “Minimum”, “Memory interval” and “Measurements”. 

The monitoring interval box has predefined values. You can see these values 
by clicking on the triangle to the right of the box. You can select your individual
value from the list.

Please remember that you can only determine when the pressure monitoring
process starts but not the start of the measurement itself. This is achieved for
OCMs by determining the pressure thresholds in the “Minimum” and “Maximum”
boxes. The values are formatted in mbar so that 1.5 bar has to be entered as
1,500 mbar. The monitoring interval is displayed in seconds and determines after
how many seconds a measurement is carried out and subsequently saved. 

Figure 3-20: OCM measuring parameters window

Because the number of values is limited to 5,500 values per measuring operation,
the data can be logged for a maximum of 15 hours and 15 minutes from the point
the operation begins when you leave the memory interval on 1. 

By increasing the memory interval you can instruct the logger to save every nth
value during the measurement, thereby increasing the length of the measuring
period. This allows you to save a maximum of every tenth value. If you set the
monitoring interval to 10 seconds, then this means that 100 seconds elapse
before any two measuring values are saved.

It is also possible to form an average of the values which are not saved and to
save this average value as a measuring value. Click on “Yes” in the “Take average
values” sector to activate the calculation.

In the “Measurements” sector you can determine the number of measurements
that you would like to be saved. You can select between 1 and 40 measurements.
Because the logger can manage a maximum of 40 measurements, it overwrites
the oldest measurement when you carry out non-stop operation controlled meas-
urements.

Deleting Measurements 

If you do not wish to send a particular measurement to the pressure logger, you
can delete the measurement in question from the table. Only the measurements
shown in the table are sent to the logger when you click on “Apply” (fig. 3-18). 

To delete a measurement from the table mark the measurement you 
wish to delete by clicking on the line that contains the measurement 
and then click on “Delete”. 

If you click on “Apply” when there are no measurements in the table, then all the
measurements which are waiting to be started in the pressure logger will be
deleted. By proceeding as described above it is therefore possible to delete a
measurement parameter list that has been programmed incorrectly.

Programming Measurements

Click on “Apply” (fig. 3-18) to start programming a measurement. 

The pressure logger can only be programmed when at least one or a maximum
of five time controlled measurements are in the table in the window. In the latter
case the “Add” button appears in grey and cannot be selected. You can only add
another measurement to the table when one of the existing measurements has
been deleted (see “Determining measuring parameters”). 

The same thing happens to the button when you have programmed an operation
controlled measurement via the “Add OCM” button. In addition, contrary to time
controlled measurements, only one OCM can be added to the parameter list. 

When all the conditions have been met, the measurements are transferred to the
logger when you click on “Apply”. If all the measurements have been transferred
correctly, you can see when the next measurement is programmed to start on
the pressure logger’s display.

“Repetitions” sector

In the “Repetitions” sector (fig. 3-18) you can define when 
another TCM is to take place. 

You must carry out the setting “daily” or “weekly” before the first measurement
takes place. If a measurement has already been entered into the table, then this
setting can no longer be changed. The number of repetitions can, however, be
determined before individual measuring parameters are set.

By selecting daily you are determining that a measurement be carried out every
day at a specific time. You can enter the number of repetitions in the "Number”
box, which means that if you enter zero, then the measurement will only be carried
out on the predefined date. 

If, on the other hand, you have programmed four repetitions, then the measure-
ment is carried out for a total of five days. The same rule applies when weekly is
selected instead of daily. In this case the repetitions are carried out weekly and
not daily.

Attention: If a measurement has been programmed and a repetition has
been defined for this measurement, then a further measurement cannot be
programmed to take place at the time the measurement is to be repeated.
It is not possible for two measurements to be carried out at the same time.
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Setting Alarm Parameters 

The pressure logger is equipped with a feature which is designed especially for
use in GSM mode. It can generate an alarm when minimum and maximum pres-
sure thresholds are exceeded irrespective of the type of measurement which has
been selected (OCM or TCM). 

When the pressure logger is combined with a GSM modem, then an alarm can
be sent to a mobile (see chapter 3.2.4) when the pressure thresholds have been
exceeded.

Figure 3-21: Alarm parameters dialogue

To activate the alarm click on “Set alarm parameters” (see fig. 3-18). 

When you click on the button, the dialogue as shown in fig. 3-21 appears. You
can use this dialogue to set the pressure thresholds and to activate or deactivate
the alarm. 

The interval limit for the alarm cancellation also determines how many measuring
points are collected after the pressure has returned to within the pressure thresholds
so that the alarm can be reset.

When you click on “Apply” the data is saved temporarily, but not transferred to
the logger. The alarm parameters are written into the pressure logger when the
measuring parameter list has been transferred to the pressure logger (see “Pro-
gramming measurements”). 

When you click on “Close”, then no alarm parameters are transferred 
to the pressure logger.

3.5.6 Changing the Logger Language

The language setting is another one of the toolbar’s context relevant functions
on the toolbar. This function enables you to change the logger’s display language
and to use your own language provided the logger supports this particular language. 

The logger’s language settings can only be changed via the program 
and not at the device itself. 

With the company software 2.1 the device supports the languages German,
English, French, Slovenian and Italian. In order to be able to use this function to
its full potential the conditions as described in chapter 3.5.1 must also be met.

3.5.7 Stopping the Current Measurement 

If a measuring parameter list determining which measurements are to be carried
out has been saved in the pressure logger (see chapter 3.5.5), you can use this
function to delete the programmed list. 

In this case all the measurements in the parameter list which are waiting to be
carried out will be deleted. 

In addition the measurement which is currently being carried out will be stopped
and saved into the pressure logger’s memory. Because the measurement has
been terminated prematurely not all the measurements which have been
programmed will be collected.

3.5.8 Resetting the Alarm Counter 

The alarm counter described in the section “Setting the alarm parameters”
registers the number of times an alarm is triggered, i.e. the number of times the
upper or lower pressure threshold is exceeded. 

This function enables you to delete the alarms that have been saved and 
to reset the alarm counter to zero.

3.5.9 Printing Selected Measurements 

As was the case with the previous function, this function is also context dependent
and provides you with a different result depending on the selected object in the
sector “Pressure logger and measurements” (see chapter 2.4.1). 

When a pressure logger has been selected, this print function can be used to
print out information on the logger. 

If, on the other hand, a measurement has been selected, the program will print
out the graphic shown in the sector “Measuring curve” along with any additional
information that has previously been entered in the dialogue box “Additional in-
formation” (see chapter 4.2.3). 

When you have clicked on “Print selected measurement”, a dialogue window
will appear with a preview of the document you wish to print out.

There are a number of functions available in the toolbar (fig. 3-22) with which
you can edit the document if necessary. 

Figure 3-22: Print dialogue toolbar

You can use the magnifying glass symbols “+” and “–“ to enlarge or reduce
the size of the preview of the document you wish to print out. 

You can use the “<” and “>” symbols to reach another page if 
the document consists of more than one page. 

Click on the printer symbol that has a tick mark to reach the dialogue window in
which you can determine the size of sheet and the format (portrait or landscape)
you would like to select. 

Click on the first print out symbol in the toolbar to print out the document.

3.5.10 Excel Export 

You can use this button to export the measurement values into a CSV file. CSV
(Comma Separated Values) is a way of depicting data using semi-colons to 
separate the individual measuring values from one another and saving it in a file
that can then be edited using Excel. 

When you click on “Export a selected measurement”, a window will 
appear in which you can enter the memory place as well as the 
file name for the Excel file. 

Click on “Save” to finish exporting the file. This button is always available in
single image view (see chapter 4.2.1). When you use the overlapping view, you
have to define the sector that is to be exported in first. See section 4.2.2 to find
out more about exporting in overlapping view.

3.5.11 Deleting Measurements 

You can use this function to delete a measurement which you no longer need. 

To delete a measurement first mark the measurement by left clicking on it. Then
click on “Delete selected measurement” to delete the measurement from the
database.
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3.5.12 Overlapping measuring curves 

Click on this button to overlap measuring curves. This function enables you to
present measuring curves with different starting times in one diagram and to put
individual measuring points on the same position. 

When you click on “Overlap measuring curves”, a new window opens. 
You can select which measuring curves you would like to overlap 
in this window (fig. 3-23). 

You can select which measuring curves you would like to depict in the diagram
by clicking in the first column and placing a tick there. Then click on “Apply” to
show your selection in the “Measuring curve” sector. 

If there are too many measurements in the “Select a measuring curve” window,
then you can sort out which measurement you would like to keep and which you
would like to discard by clicking on the head of the table. Depending on how 
you click the table will be sorted according to the time the measurement was
started, the interval time or the name of the measurement. 

See chapter 4.2.2 for more information on further functions which this display
mode has to offer.

The program version 1.0.3.20 only allows you to overlap TCMs. This is why you
are not able to select an OCM in the dialogue shown in fig. 3-23.

Figure 3-23: “Select a measuring curve” window

3.5.13 Zoom Autoadjust 

If you have changed the zoom in the diagram in the “Measuring curve” sector,
you can use this function to reset the zoom to its initial status. The measuring
curve will then be displayed in the diagram with all the measurement values. 

This function is only available when a measurement has been previously selected
in the “Pressure logger and measurements” sectors.

3.5.14 Zooming In 

The zoom in function enables you to enlarge the diagram in order to be able to
view a section of the diagram in more detail. 

Because the diagram has a horizontal and a vertical axis, there are two symbols,
one for each axis. That means that you can enlarge the vertical axis, i.e. the axis
on which the pressure is displayed, by clicking on the first zoom-in symbol and
the horizontal axis, i.e. the axis on which the time is displayed, by clicking on the
second zoom-in symbol.

3.5.15 Zooming Out 

Just as it is possible to zoom in on a diagram it is also possible to zoom out again
in order to gain a better overall view. You can also zoom out of both axes, sep-
arately. The first zoom-out symbol can be used to reduce the size of the vertical
axis and the second zoom-out symbol to reduce the size of the horizontal axis.

3.5.16 USB Mode 

As described in chapter 3.3, the program can be used in two different modes.
One of the modes is the “Serial / USB mode”, which allows you to read out the
pressure logger via the readout unit connected to the computer. 

The button shows you which communication mode the program is currently in.
You can either switch between the two modes by following the steps described
in chapter 3.3 or by clicking on this button.

3.5.17 GSM Mode 

The second communication mode is “GSM mode”. When the program is in this
mode, communication between the program and the pressure logger is effected
via a GSM connection. 

This button also shows you which mode the program is currently in. In much the
same manner as described above, you can also change the mode directly by
clicking on the button.

3.5.18 Disconnecting 

If an error occurs while a connection is being built up to a pressure logger or
during the time the logger is connected, you can use this function to either
disconnect the logger or to terminate the dial up. 

When you click on the button, it takes a few seconds for the program to dis-
connect the connection and make the communication port available again. 

This function can also be used to build up a connection to a different logger.
Although the program is able identify that a connection already exists and also
able to disconnect this connection automatically, you can disconnect the con-
nection manually by clicking on this button.

4.  Sector Functions
The following chapter is designed to provide you with an overview 
of the program’s window functions.

4.1 “Pressure Logger and Measurements” Sector
This sector of the program shows the pressure loggers and measurements which
have been saved into the readout circuit board (fig. 4-1). 

Measurements which already exist in the database are listed automatically under
the pressure logger circuit board icon when the program starts and receive a
green icon that symbolises a paper document. 

The pressure loggers which have been read out are listed after the measurements
which have already been saved and receive a blue icon which is meant to sym-
bolise a pressure logger. If there are any new measurements which have not yet
been saved into the database in the pressure logger, then these are read out auto-
matically by the program and placed below the logger icon in the display.

Figure 4-1: “Pressure logger and measurements” sector

If an error occurs while the data is being read out, the program generates an error
message which appears on the display. Such errors can occur when measure-
ments are being read out. 

Measurements whose data sets have not been read out completely are also
labelled with an icon which is shown on the display. This icon comprises a red
triangle with a white exclamation mark. 

By selecting the same measurement again you can instruct the program to repeat
the procedure and read out the measurement.

Attention: Measurements whose icon contains a red triangle with a 
white exclamation mark are not saved into the database by the program.
This means that these measurements will not be shown when 
the program is restarted.
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When the program has started and neither a pressure logger nor a measurement
has been selected, the only buttons available in the toolbar (see chapter 3.5) are
“Read out pressure logger” and “Overlap measuring curves”. 

In this program state you can either read out the pressure loggers which are in
the readout circuit board (see chapter 3.5.1) or overlap measurements which are
already in the database. You must mark either a measurement or a pressure
logger in order to be able to use the other functions in the toolbar. 

When you have marked a measurement by left clicking on the measurement, you
can use the functions “Print selected measurement” (see chapter 3.5.9), “Excel
export” (see chapter 3.5.10) or “Delete measurement” (see chapter 3.5.11). 

When you have marked a pressure logger, use the functions “Set pressure logger
time” (see chapter 3.5.2) and “Program measurement” (see chapter 3.5.5). The
functions “Reset pressure logger” (see chapter 3.5.3), “Real-time readout”
(see chapter 3.5.4) and “Change language” (see chapter 3.5.6) are also available. 

The functions “Read out pressure logger” and “Overlap measuring curves” are
context independent and can be used irrespective of the objects which have 
been selected and are shown on the display.

In addition, more detailed information appears under the window “Pressure logger
and measurements” (fig. 4-1, right) when a measurement or a pressure logger
has been selected. The information shown there depends on the selected object
(see section 2.4.1).

When you are in GSM mode (see chapter 3.3) and you select a pressure logger,
the program checks if there is already a GSM connection to the pressure logger
you have selected and the program. 

If the pressure logger is not connected to the program, the program will ask you
whether a connection should be set up or not. You can answer with either “Yes”
or “No”. If you click on “Yes”, the program will automatically set up a connection
to the pressure logger. The relevant buttons in the toolbar (see chapter 3.5) are
now activated and can be used. 

If a GSM connection to a selected logger already exists, the program will ask you
if this connection should be disconnected before it sets up a connection to another
pressure logger. 

4.2 Measuring Curve Sector
The values of the pressure loggers which were selected in the “Pressure logger
and measurements” sector are displayed as a diagram (see fig 2-5) in the “Mea-
suring curve” sector. 

If a pressure logger has been selected in the “Pressure logger and measurements”
sector, then nothing will be displayed in this part of the program 

The measuring values are displayed as a line diagram. The y-axis represents the
pressure values and the x-axis represents the time. The time on the x-axis is
shown in hours, minutes and seconds (hh:mm:ss) for a measuring curve. 

If several measuring curves are to overlap, the units can also be in 
months and years, depending on how far apart the starting times of the 
individual measurements are. 

In addition, this sector also enables you to gain detailled information on a meas-
uring value by placing the cursor on the measuring value and allowing it to remain
there for a few moments. 

The program will now show you the so-called “Tool tip”. The “Tool tip” shows
you the date and the exact value of the measuring point.

The diagram has a pop-up menu which appears when you right 
click into the diagram. 

You can use this menu to change the scale of the vertical axis and to transform
the pressure values into height values. The scale then also changes from mbar
to metres.

Further functions which the program provides you with can be accessed via the
respective “Divide”, “Calculate”, “Overlap” or “Mark” buttons. See chapter 4.2.1
to find out more about the first two functions as these two functions are only
available in this particular view. See chapter 4.2.2. to find out more about the
latter two functions. 

4.2.1 Single View Image

There are a number of further functions available in this sector which can be used
by pressing the buttons as shown in figure 2-5. If you are in single view image,
i.e. the measuring curve is depicted in this sector as a single diagram, then 
press either “Divide” or “Calculate” to divide up the measuring curve or cal-
culate the pressure difference between the maximum and minimum pressure
value of a measurement.

Dividing

The “Divide” button enables you to extract certain parts of the measuring curve.
You can extract either one part or more than one part. 

After you have clicked on “Divide”, mouseover the line diagram. A vertical blue
dotted line which follows every horizontal movement your mouse makes is now
drawn into the diagram. 

This line determines which section is to be extracted, i.e. defines the starting point
and the finishing point of the sector you wish to extract. 

When you left click into the diagram and move your mouse to the left, the 
program draws a yellow area into the diagram. Move the mouse to change 
the size of the area. 

Click into the diagram again to complete drawing in the sector you wish to extract.
Now only the blue line will follow the movements you make with your mouse. 

This procedure can be repeated depending on the number of measuring curves
you would like to extract out of a single measuring curve.

Figure 4-2: Dividing up a measuring curve

When all the sectors that you would like to extract have been marked, click on
the button again to complete the procedure. The marked sectors are then removed
from the diagram and the new measurements are added to the “Pressure logger
and measurements” sector.
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Calculating

This function can be used to calculate pressure differences in a measuring curve.
First draw two marked areas into the diagram. 

A red area, which represents the marked area for the high pressure, and a green
marked area, which represents the low pressure area. 

All the measuring values which are within a marked area are drawn upon by 
the function designed to calculate the pressure difference. The pressure difference
is calculated using the mean values of the measuring values which are within
the marked area. 

Figure 4-3 shows the two marked areas. Following this the calculated values are
shown in the “Pressure logger and measurements” sector (see fig. 2-4).

Click on “Calculate” to start the calculation and mouseover the line diagram. A
vertical blue dotted line which follows every horizontal movement your mouse
makes is now drawn into the diagram. 

This line determines the boundaries of both your marked areas, i.e. defines the
starting point and the finishing point of the marked area.

Figure 4-3: Calculating the pressure difference

When you left click into the diagram and move the mouse left, the program first
draws a red area into the diagram. Move the cursor to increase or reduce the
size of the diagram. 

Click into the diagram again to complete drawing in the red area. The measuring
values that are needed to calculate the high pressure values are now marked.
The blue line now follows any horizontal movements which you make with your
mouse. Then draw the green area which calculates the mean value for the low
pressure into the diagram. Proceed as you did when drawing in the red area. 

When you draw in the end of the marked area, i.e. when you click into the diagram
for the second time to close the marked area, the function automatically removes
the drawn in areas and shows the calculated values (see figure 2-4).

4.2.2 Overlapping View

When the view that is shown displays more than one measuring curve, you can
overlap several measuring curves or select data sectors which can then be
exported to Excel by clicking on “Overlap” or “Mark” respectively. The following
sections describe how to use these functions.

Overlapping

When you select the display mode with more than one measuring series (chapter
3.5.12), you can select the function that enables you to overlap measuring curves.
This function can be used to overlap any number of measuring points from
measuring series, i.e. the measuring points (one per series) which are to overlap
can be selected at random from a measuring series. 

Left click to mark the measuring points you would like to overlap. A vertical red
line which crosses the marked point is now drawn into the diagram. 

Proceed in the same way to mark further measuring series. Left click into an empty
part of the diagram to delete any markings you may have carried out (see fig. 4-4).

The markings you have set are then deleted and you may start again. 

Click on “Overlap” to overlap the measuring curves when all 
the markings have been set.

Figure 4-4: Overlapping measuring curves

Marking

You can also export measuring values in overlapping mode. You can only export
the measuring values which have been marked previously in this mode. 

The function “Export selected measurement” is not available as standard in 
this view (fig. 3.5.10). It becomes available when the measuring values have 
been marked accordingly.

Figure 4-5: Marking the export sector

Click on “Mark” to activate the function. A vertical blue dotted line which follows
every horizontal movement which your mouse makes is now drawn into the
diagram. This line determines the boundaries of the marked area, i.e. defines the
starting point and the finishing point of the marked area. 

Left click into the diagram and move the mouse to the left. The program draws
a grey area into the diagram. Move the mouse to change the size of the area.
Click into the diagram again to finish drawing in the marked area (see fig. 4-5).
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The function “Export selected measurement” is now available. Proceed as 
described in chapter 3.5.10 to export the marked area. 

When you have finished exporting the data, end the marking function by clicking
on “Mark” again. The marked area is removed from the diagram and the function
“Export selected measurement” is no longer available.

4.2.3 Additional Information on Windows

In single image view you can add additional information to a diagram in the
database. This additional information is also printed along with the diagram when
the diagram is printed out. 

If no information has been added, then the relevant boxes in the measuring pro-
tocol remain empty. You are then free to end additonal information by hand when
the protocol has been printed out.

To add information to a measurement, select the measurement in the “Pressure
logger and measurements” sector so that the measuring curve can be shown
in the “Measuring curve” sector. 

Then double click into the diagram to open the “Additional information” window.
Now you can add the information to the window.

Complete on “Apply” to complete the procedure. The information is 
now saved into the database. 

Click on “Close” to reject your entry and terminate the procedure.

Figure 4-6: Additional information window
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